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Introduction 
 
This manual will detail most of the menu options found in the Word 2003 menu View.  
The View menu options discussed in this manual are: 

◘ Normal, Web Layout, Print Layout, Reading Layout, Outline 
◘ Ruler 
◘ Document Map 
◘ Thumbnails 
◘ Header and Footer 
◘ Footnotes 
◘ Full Screen 
◘ Zoom 
 

Each menu item will be defined and will provide reasons to use that particular menu 
option.  Following the background information, there will be a Step-by-Step that will 
provide instruction on how to use the tools and commands.  Some processes that you 
perform from the menu, can also be done other ways.  If there is an Alternative method, 
this would be the last part of each lesson. 
 
Note:  The Task Pane and Toolbars options are not discussed in this manual.  Please see 
the Introduction to the Word 2003 Series manuals for how to use these options. 
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Normal, Web Layout, Print Layout, Reading Layout, Outline 
 
Definitions 
Word Definition 
Normal View Shows the page with simplified layout for easy typing, editing and 

formatting.  Not all capabilities are available with rulers. 
 

Web Layout View Shows how the document will look as a web page. 
 

Print Layout View Shows how the items in your document will be positioned on the 
printed page. The rulers are present.   
 

Reading Layout 
View 

Shows the document in a manner that is optimal for reading.  This 
view does not display the document in a way the document is 
formatted for printing. 
 

Outline View Shows the structure of a document and you can move, copy, and 
reorganize text by dragging headings.  Styles must be used 
consistently for this view to work successfully. 
 

 
Why would you use this? 

◘ You would use the different views to tailor your working window to meet 
your needs for the specific document and task.  

◘  
 
Step by Step 

What you do What happens 

1. From the menu choose: 
View, Normal 
 
 
 
Notes: 
 You cannot use the Drawing 

toolbar in this view. 
 The headers and footers are not 

visible in this view. 
 Page breaks appear as dotted 

lines. 

The Normal view displays. 
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What you do What happens 

2. From the menu, choose: 
View, Web Layout 

The Web Layout view displays. 

 
 

3. From the menu choose: 
View, Print Layout 
 
 

The Print Layout view displays. 
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What you do What happens 

4. From the menu choose: 
View, Reading Layout 
 
Reading Layout is new in Word 
2003.  You may have noticed if 
you open an attachment in 
Outlook, this is the default view.  
To turn this option off go to Tools, 
Options.  Go to the General tab 
and uncheck the option for Allow 
starting in Reading Layout. 
 

The Reading Layout Displays. 

 
 

5. From the menu choose: 
View, Outline 

 
Notes: 
 You can use the expand and 

collapse buttons in the left 
margin. 

 

The Outline view displays. 
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Alternative Methods 
What you do What happens 

1. An alternative method to using the 
menu would be to use the View 
buttons in the bottom left corner of 
the window.  
 
If you rest the cursor over each 
icon, a screen tip will display with 
the view name. 
 

The View icons. 
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Ruler 
 
Why would you use this? 

◘ To get an idea of where you are on a page in terms of measurements. 
◘ To set tabs and indents. 
◘ To change the margins. 
◘ Adjust column widths. 
◘  

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
View, Ruler 
 
This is a toggle selection.  If there 
is a checkmark next to the 
selection the rulers will be visible.  
 
Notes: 
 The horizontal ruler is only 

visible in print layout, normal, 
and web layout views. 

 The vertical ruler is only 
visible in print layout view. 
 

 

2. If the rulers do not appear after you 
select this option, go to the menu 
option: 
Tools, Options 
 
On the View tab, check (or 
uncheck if you want one or both 
removed) Vertical Ruler. 
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Document Map 
 
Definitions 
Word Definition 
Document Map Pane that displays a list of headings in the document.  Use it to 

quickly navigate through a document and keep track of your 
location in it. 
 

 
 
Why would you use this? 

◘ To quickly navigate through the document. 
◘ To help keep track of your location in the document. 

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
View, Document Map 

A side pane with the outline of the document displays. 

 
 

2. The location you are currently at in 
the document will be highlighted. 
 
To go to a different location in the 
file, click on it in the side pane. 
 
Note:  You need to utilize Word 
Styles for the Document Map to 
provide an outline of the 
document. 
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3. To turn the Document Map off, 
choose from the menu (again) 
View, Document Map. 
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Alternative Methods 
What you do What happens 

1. To turn on Document Mapping, 
you can click on the Document 
Map  icon found on the 
Standard toolbar. 
 

 

2. To turn off Document Mapping, 
you can click on the Document 
Map  icon again.   
 
This is a toggle button. 
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Thumbnails 
 
Definitions 
Word Definition 
Thumbnails (Per Microsoft Help) Small renderings of each page in your 

document, displayed in a separate pane.  Thumbnails give you a 
visual impression of the content of each page.   

 
 
Why would you use this? 

◘ To get a glimpse of the entire document as you are working. 
◘ To quickly jump to a page by visually identifying it. 
◘  

 
Step by Step 
 

What you do What happens 

4. From the menu choose: 
View, Thumbnails 
 

The Thumbnail pane displays. 

 

5. You can use the vertical scroll bar 
to the right of the pane to move 
through the document via 
thumbnails.   
 

 

6. You can quickly jump to any page 
in the document by clicking on the 
thumbnail. 
 

 

7. This is a toggle option.  To turn the 
Thumbnail view off, reselect it 
from the menu. 
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Header and Footer 
 
Why would you use this? 

◘ To add a document name to the file in the top or bottom margin. 
◘ To add a date to the document in the top or bottom margin. 
◘ To add page numbers to a document in the top or bottom margin.  
◘  

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
View, Header and Footer 
 

The Header and Footers display. 

 

2. The header and footer sections of 
the document are available for 
entry. 
 
The Header and Footer toolbar 
appears as well. 
 

 

3. You can enter text into the header 
and footer areas.   
 
The Tab key will move you from a 
Left tab, to a Center tab, and then 
to a Right tab. 
 

 

4. To insert a page number, click on 

the Insert Page Number  icon 
on the toolbar.  
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What you do What happens 

5. To format the page number, click 
on the Format Page Number 

icon. 

The Page Number Format box displays. 

 
 

6. You can format the page number 
on this box.   
 
You can also force Word to start 
the page number at a number other 
than 1.  You would do this if you 
set the option for a different first 
page.  To do this, you want to click 
in the radio button for Start at and 
then enter the page number you 
want started on this page.   
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What you do What happens 

7. On the Header and Footer toolbar, 
you can click on the Page Setup 

 icon. 
 
On the Layout tab you can click on 
the options for Different odd and 
even.  This is a great option if you 
are going to be printing the 
document as a manual.  This 
option will give a “mirror effect” 
with the header and footers. 
 
You can also select the option for 
Different first page which will 
allow you to have a different (or 
not any) headers and footers on 
just the first page of the document.
 
Other helpful options on this box 
are the Header and Footer (From 
edge) fields. You can make the 
header and footers closer to the 
edge or further from the edge.  

The Layout tab. 

 
 

8. Later, you can edit a header and/or 
footer by double clicking on the 
text.  This will open the header and 
footer areas for editing as well as 
the Header and Footer toolbar. 
 
You can also use the menu option 
of View, Header and Footer to 
open the areas for editing. 
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Footnotes (view) 
 
Definitions 
Word Definition 
Footnote A footnote provides an explanation for specific text in the 

document and it appears at the bottom of the page that the specified 
text is found.  A footnote consists of a reference mark and note text.  
The reference mark is typically a number and the reference mark 
then matches the number next to the footnote at the bottom of the 
page. 
 

 
Here is an example of a footnote: 
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Why would you use this? 
◘ To provide an additional explanation for something in the document. 
◘ To add comments for specific text in a document. 
◘ To provide references for a specific text in a document. 
◘  

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
View, Footnotes 
 

The cursor goes directly to the footnotes on the closest 
page with footnotes. 

 
 

2. To find out how to create 
footnotes, see the manual for the 
Insert menu options.   
 
Adding footnotes can be done by 
using the menu option of Insert, 
Reference, Footnote. 
 

 

 
Alternative Methods 

What you do What happens 

1. You can directly go to any 
footnote, by scrolling to the bottom 
of a page with the footnote and 
double-clicking over the footnote 
number.  
 

 

 



Word 2003: View Menu Option  The University of Akron 

 
Ver. 2005.09.27 Learning Technologies/Software Training Page 17 

©2005 The University of Akron.  These materials may not be reproduced in whole or in part without the express 
written permission of The University of Akron 

 

Full Screen 
 
Definitions 
Word Definition 
Full Screen  Shows you the document in the entire screen area.  This view 

removes the toolbars and menu.   
 

 
 
Why would you use this? 

◘ To start off a presentation or training session with a title or introduction slide. 
◘ To view your document without the toolbars and menus. 
◘  

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
View, Full Screen 
 

The window appearance adjusts: 
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What you do What happens 

2. There is a Full Screen floating 
toolbar available. 

 
 
You can click on the Close Full 
Screen button to return to the 
previous view.   
 
You can also click on the Esc key 
to return.   
 

 

3. If you need to access the menu, 
move the cursor over the top of the 
window (where the menu would 
be) and it will appear.  In the Full 
Screen view, it is hidden.   
 

 

4. You may want to adjust the Zoom 
before doing this.  This will allow 
you to see the maximum amount of 
information in this view. 
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Zoom 
 
Why would you use this? 

◘ To see more or less of your document while you are working.  
◘ To view the document in thumbnails.  
◘  

 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
View, Zoom 
 

The Zoom box displays. 

 
 

2. You can adjust the zoom of the 
page by 200%, 100%, 75%, Page 
width, Text width, Whole page, or 
Many pages.   
 
You can also put in a manual 
number in the Percent field.   
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What you do What happens 

3. Click on the OK button to return. 
 

The page with the new zoom. This is an example of Many 
pages. 

 
 
 
Alternative Methods 

What you do What happens 

1. Click on the drop down arrow for 
the Zoom toolbar button. 

 

The Zoom drop down expands. 

 
 

2. Scroll down and make a selection. 
 

 

3. You can also manually enter a 
number in the Zoom field and 
press the Enter key. 
 

 

 


